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About This Manual
This manual, as well as the software described in it, is furnished under license and may only be used or copied 
in accordance with the terms of such license. The information in this manual is furnished for informational use 
only, is subject to change without notice, and should not be construed as a commitment by Sonic Studio, LLC. 
Sonic Studio, LLC assumes no responsibility or liability for any errors or inaccuracies that may appear in this 
book.
Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval 
system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without 
the prior written permission of Sonic Studio, LLC.

Notice of Liability 
The author and publisher have made every effort to ensure the accuracy of the information herein. However, 
the information contained in this document is provided without warranty, either express or implied. Neither 
the authors, Sonic Studio, LLC, nor its dealers or distributors will be held liable for any damages to be caused 
either directly or indirectly by the instructions contained in this book, or by the software or hardware products 
described herein.

SONIC STUDIO, LLC MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING 
WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE. 
SONIC STUDIO, LLC DOES NOT WARRANT, GUARANTEE, OR MAKE ANY 
REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE 
SONIC STUDIO, LLC SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, 
RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE 
RESULTS AND PERFORMANCE OF THE SONIC STUDIO SOFTWARE IS ASSUMED 
BY YOU. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME 
STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.
IN NO EVENT WILL SONIC STUDIO, LLC, ITS DIRECTORS, OFFICERS, EMPLOYEES, 
OR AGENTS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, OR 
INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, 
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) 
ARISING OUT OF THE USE OR INABILITY TO USE THE SONIC STUDIO SOFTWARE 
EVEN IF SONIC STUDIO HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE 
ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

Notice of Rights 

©2007-2011 Sonic Studio, LLC — All rights reserved. No part of this document may be reproduced, stored 
in a retrieval system or transmitted in any form or by any means, without the prior written permission of the 
publisher.
Sonic Studio, Amarra, MINI, Amarra Junior, SSE, NoNOISE native, Sonic EQ, Model 302, Model 303, Model 
Four, Model 305 and the Sonic Studio and Amarra logos are trademarks of Sonic Studio, LLC. All other 
company or product names are either trademarks or registered trademarks of their respective owners.



1. 0.0  Thank you!

Thank you for purchasing the MINI Computer Music Player.  You are about to enjoy the Ultrafidelity sound of 
Amarra. Designed to work with your Apple™ MacIntosh Computer and with iTunes, MINI provides a seamless 
integration for high resolution music playback.

The Amarra Team
Sonic Studio, LLC
330 Sir Frances Drake Blvd, Suite A  San Anselmo, CA USA  94960-2552
phone: 1-919-426-2772
support@sonicstudio.com
www.amarraaudio.com

This document details the installation of MINI and its associated software.

The MINI 2.3 installer will install the following items on to your Macintosh Computer:

• MINI 2.3 Computer Music Player
• MINI Documentation
• FLAC Component

2.0.0  Minimum System Requirements:

Computer: 
• Any Intel–based Mac
• RAM: 3 GB memory, 4 or more preferred (8 GB recommended for best CACHE Playback)  
• For best results a high performance USB/FireWire audio interface
• Software: 
	 • Mac OS X 10.5, 10.6 and above recommended
	 • MINI software
	 • iTunes

Supported Audio Hardware Interfaces: 
• Most Core Audio Interface will work with MINI. This includes USB, FireWire, and optical connections 
on the Macintosh. Please visit the Hardware section of www.amarraaudio.com for more information.

	 Peripheral FireWire Adaptors supported: 
	 • OHCI compliant PCCard, PCI card, ExpressCard or PCIe card
	
We recommend a fresh install of the operating system on a clean disc. This can prevent problems later on.
We also highly recommend that your computer be used exclusively for music playback. Email, web browsers, screen 
sharing and other applications can all affect performance.

3.0.0  Installing MINI Software:

To install MINI, insert the install disk in your computer or locate the download of MINI, then click on the 
MINI_Installer icon.  Follow the on screen instructions to install your software. 
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Welcome screen for MINI Installer:

Select Continue.

Software License Agreement: 

Select Continue.

Agree to the Software License Agreement 

Please Read Carefully.  Select Continue.
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Select Agree to agree to the End-User Software License Agreement

Install MINI :

Click Install. 
(You will be prompted for your Mac password and the software will be installed.)
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Success!
Select the Close button to quit the MINI installer.

• MINI Computer Music Player is installed into the Applications folder.
	  It is installed here:  ~/Applications/MINI 

• MINI FLAC installs QuickTime components used for native FLAC playback.
	 They are installed here: ~/Library/Components/

3.1 Uninstalling MINI Software 

To remove MINI and uninstall the software please run the “unistall amarra command”in the Extra’s Folder.  
This script may prompt you for your password and will remove MINI and all installed components.

4.0.0  Authorization Of  Your Software ::

Amarra is licensed for use via a simple Internet Authorization process.  Please follow the steps below to 
Authorize your software.  Also see Section 8 of this document for answers to questions regarding our 
authorization process. 

Your software is licensed for use via a simple Internet Authorization process.  Please follow the steps below 
to Authorize your software.  

1)  When you launch MINI the first time, you will be presented with the Authorization dialog 
box, Figure 1, below.
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Figure 1:  Authorization dialog box.

Evaluate button:  Allows the software to run in Evaluation Mode for a specific time.  
                        Only your email address is required for Evaluation.  No other entry is required.
Activate button:  Securely sends your Activation Code, email address and unique password to 
authorize the software.
Deactivate button: Deactivates the software on the current computer and allows you to Activate 
MINI on another computer.
Send Password button:  Sends the password you define to the email you provided.
Buy button:  Takes you to an online store to purchase MINI.
OK button:  Cancels and closes the Authorization window.

2) Enter information into the provided fields..

A) Copy and Paste your Activation code into the Activation Code area.  
B)  Add your email address and create your own unique password in the appropriate fields. (See 
Figure 2).  Note:  Your password should be something simple such as MINI01. 
C)  Click on the Activate button to activate your Amarra product.

IMPORTANT NOTE:  
Your Activation Code is delivered to you via email.   If you purchased Amarra before April 15, 2011, 
use your Amarra product Serial Number as your Activation Code.
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Figure 2: Sample Authorization dialog box with all fields filled out.  Note simple Password.

Success!  Your Amarra Software has been authorized.

NOTE:  Note: When you reactivate a new release of MINI, or move MINI to another computer you 
will be asked for a new password.  The window below will appear, type in a new password and click 
‘OK’.  

NOTE: To prevent Lockout use the “Send Password” button to have your password sent to you.  

WARNING : After 3 attemptls with an incorrect password a lockout will occur.  Write to support@sonicstudio.com 
if you have a lock out and support will clear it.

Enter a new password to reactivate your copy of MINI.

Authorizing MINI After Evaluation Period Expires ::

After the Evaluation period has expired, it’s easy to receive an Activation Code that enables you to continue to enjoy 
the ultrafidelity sound of MINI.  Simply select the Buy button and you will be directed to an online store to purchase 
MINI.

Your Activation Code will be sent to you via email.  Once you receive your Activation Code, follow the steps outlined 
above to authorize your copy of  MINI.

Information About The Authorization Process ::

Activation is a set of simple and quick steps taken after your purchase of MINI. It entitles you to use MINI on your 
computer. If you’ve purchased products online or installed many of the Adobe products you have already used a 



Page #10

MINI 2.3 User Manual

similar activation system. When your application is authorized it contacts a central server across the internet 
to ‘activate’ your software and tie it to the provided activation code (which is generally provided by email). 
 
This anti-piracy system helps protect your investment in Amarra and enables us to continue its development 
at a competitive price. The license protection and monitoring system is managed by software_DNA from 
softWORKZ Innovation Inc. This system does not collect any details about you or your computer during 
license activation and re-activation. 
 
Unlike other activation systems, the software_DNA system for Amarra does not tie your license permanently 
to your computer hardware. Instead, your license is tied to your activation code and password that you define. 
As a result, you will have no problem re-activating your software after reformatting your hard drive, after 
upgrading hardware components in your computer, or when you move your software to a new computer. 
However, activation and re-activation does require an Internet connection. This Internet connection can be on 
a different computer from where your application is installed.              
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5.0.0  Launching and Using MINI

Open the Applications folder on your Mac, locate the MINI folder.  
This folder contains the MINI application as well as documentation and an Extras folder.

Click on the arrow to the left to open the folder :

 
MINI folder and the MINI application.

NOTE:  Launch MINI first, not iTunes.  Double clicking on the MINI icon launches MINI and iTunes.

HINT:  Drag and drop the MINI application icon to your dock for easy launch.  

MINI and the Finder Dock.  (For more information about the Dock, see the Help menu of your Mac.)
Using the Control Key to access the Contextual Menu allows control of different commands in MINI.
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5.1.0  MINI Application Menus ::

5.1.1  The MINI Menu:

About MINI: Opens the modal About window. This is useful for verifying the version number of MINI that you are 
running. Click anywhere in the window to close it.
Preferences: Opens the Preference window for Amarra. See Section 6 for more information.
Services: This menu proves access to any Services that are available to MINI. Services extend an application or 
framework‚ functionality by sharing its capabilities with other programs.
Hide MINI: Hides all MINI windows. To reveal the windows, click on the Dock icon or tap the ‚+tab key to cycle through 
running applications to select MINI.
Hide Others: Hides all windows other than MINI.
Show All: Reveals all windows.
Quit MINI: Quits MINI.

5.1.2  The File Menu:
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Set Amarra Source [cmd+1]: : Sets Amarra as the source for playback.
Set iTunes Source:  [cmd+2]:: Sets iTunes as the source for playback. Toggling between ‚+1 and ‚+2 is a 
			   good way to compare sound quality between Amarra and iTunes.
Set Playlist Source: [cmd+3]:  Sets Amarra’s Playlist as the source for playback.

Convert FLAC File to AIFF... : Navigate to FLAC files and convert them to AIFF format. 
			   The shift and ‚(command) keys allow you to select more than one file.
Convert FLAC Folder to AIFF... : Navigate to a folder containing FLAC files and convert the folder’s contents to AIFF.

Authorization... : Opens the Amarra Authorization window. See section 4 for more information.
Audio MIDI Setup‚: Opens the Audio MIDI Setup window. This is useful for configuring your DAC.
Rescan I/O: Forces MINI to query Core Audio for current interface status.

Eject Disc [cmd+E]:  Ejects the CD from tray.
Extras... : 

Cut: Cuts the currently selected string or item to the Clipboard.
Copy: Copies the currently selected string or item to the Clipboard.
Paste: Pastes the currently selected string or item from the Clipboard.

Enable Debugging: Allows Amarra to log detailed information on its operation.
Send Crash Report: Should a application crash occur, sends important information to Sonic Studio technicians.

NOTE:  Toggling between Cmd+1 and Cmd+ 2 is a good way to compare the sound quality 
between MINI and iTunes.
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5.1.3  The Playlist Menu:

Add Tracks From iTunes: [sft+cmd+i]  Adds tracks selected in iTunes into an MINI Playlist.
Add Consecutive Tracks [opt+cmd+i]:  Adds consecutive tracks from iTunes.  A specified number of tracks are loaded.  
See the MINI Preferences section 6.3.  After the tracks in the Playlist are played, more get loaded automatically.
Add Tracks From Finder... [cmd+o]: Select and add audio tracks from the Mac Finder.

Clear Playlist:  Clears the content of an MINI Playlist.
Open Playlist:  Opens a saved Playlist.
Save Playlist:  Saves open playlist for later recall.

5.1.4  The Desk Menu:

Open Sonic EQ Setup...:  A Finder window opens and allows you to navigate to a previously-saved Sonic EQ Setup.
Save Sonic EQ Setup:  A Finder window opens and allows you to save and name the current (open) Sonic EQ Setup 
for future recall.
Save As Default: Save the current (open) Sonic EQ Setup as the Default EQ.  Each time you launch, this Sonic EQ 
Setup will be recalled and enabled.
Toggle Mute [opt+cmd+M] : Turns Mute on and off, cutting the volume to 0, then returning the volume to the previous 
level.

5.1.5  The Windows Menu:
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MINI [opt+a]:  Opens the main MINI window.
iTunes [opt+i]: Opens the main iTunes window.
Playlist: [opt+p]: Opens the MINI Playlist window.  Must enable Playlist mode.
Equalizer [opt+E] : Opens the Amarra EQ window.
Background Manager [opt+B]: Opens the Background Manager window.

5.1.6  The Help Menu:

MINI Help: Opens the MINI Help document.

5.2.0  The MINI Background Manager:

MINI is equipped with the Background Manager whose function is to process sample rate conversion as a background process.  
The Background Manage window largely consists of 2 areas, the “Soundfiles” area and the “Processes” area, topped by the 
Target Folder field.

To open the Background Manger, select the Windows > Background Manager command. 
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The Background Manager window.

The Background Manager utility allows:

1) The drag and drop of audio files into the Soundfiles section.
When a sound file is selected in the list, the black status bar below the list displays the sample rate, word 
length and number of channels of the selected file. Multiple sound files can be added to the list by repeating 
this action.
To remove sound files from the list, click to select the list entry and delete it by hitting the backspace or delete 
key. To clear the list of all sound files, click the Clear All button to the right of the Soundfiles list.

2) The definition of a target folder for the processed file.
In the Target Folder field, the target folder for newly created sound files is specified. To select a target folder, 
click on the Set Folder button.  A standard Mac OS browser opens, allowing you to navigate, create and/or 
choose the desired destination folder. Option–clicking on the Choose button forces MINI to use the input 
file’s folder also as the target folder.

3) The definition of a target sample rate.
The Sample Rate Conversion background process has thirteen choices of target sample rate. As with any 
SRC process, if the target sample rate matches the clock rate of the playback system, then the process is 
considered a sample rate conversion. If, however, the target sample rate does not match the clock rate of the 
playback system, then the process is considered a varispeed. In either case, the actual processed data in the file 
is identical, only the sample rate flag is different. SRC preserves pitch and duration, while varispeed produces 
modified pitch and duration from the original.

The Target Sample Rate menu includes the following choices,:

4) A Queue section to monitor the processes progress.
Processes can be deleted from the processes list by clicking on the process and then hitting the backspace 
or delete key. To clear all processes from the Processes list, click the “Clear All” button to the right of the 
Processes list.
Once all necessary processes have been selected and placed in the right processing order, they can be 
automatically performed upon the selected sound files by clicking the “Execute” button. The sound files and 
the processes to be applied upon them are then “queued” and processing commences. To indicate this action, 
the “Queue” indicator to the right of the Execute button shows the number of sound files and processes 
queued.
Once the processes are being executed, all sound files and processes remain in their respective lists. 

To abort the current process, click the Abort button and the current process will be aborted, initiating the next process in the 
Queue.



6. 0.0  Using MINI and iTunes

MINI runs alongside Apple’s iTunes program. This allows you to manage and access all your music through the 
main iTunes Music Library or through custom iTunes Playlists. 

,  MINI occupies the area to the left of your iTunes window:

MINI and iTunes.
	
You can use iTunes like you always have, select the songs / Playlists and play.  MINI will play all your songs and 
seamlessly switches to iTunes for playing back protected files such as songs purchased from the iTunes store.  

MINI plays most compressed files including FLAC, MP3, AAC, and Apple Lossless (ALAC).

NOTE: MINI does not play variable bit rate or low bite rate MP# files.

Using the Playlist button MINI allows you to load the selected tracks from iTunes into MINI as a Playlist.  With 
the Playlist loaded iTunes is Not Used and is now stopped. This is indicated by the Playlist button turning 
Green and now showing the Tracks that are loaded as a menu.

See Section 6.6 for more information on using the Playlist.

NOTE:	This feature will play the loaded tracks without any gaps. 

 NOTE: MINI will load tracks and disable iTunes so the tracks can then be played in 
MINI.  This can provide optimal sound reproduction.
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6.1.0  Using MINI:

TIP:  Want to hear that wonderful instrumental section again?  Stop MINI, double-click in the 
seconds area of the Time Display section and use the down arrow to back up 1 second per key 
stroke. Hit the spacebar to start play at the new time selection.

TIP:  Holding the Mouse (without clicking) over any button will display a  Help Tip displaying what 
the button does.

5.  AMARRA / iTUNES
This indicates Amarra’s 
       playback status: 
Blue      = Amarra is playing  
Grey     = iTunes is playing
Orange = iTunes is playing
  • sample rate not supported
  • a protected file

1.  TRANSPORT
The Previous Track, Play/Pause, 
and Next Track buttons. are 
located here.

7.  AMARRA EQ
This opens (or closes) the Amarra 
EQ window. Option click to enable/
disable EQ.  The presets are shown
above.

2. MINI VOLUME
This slider controls the output 
volume.
The buttons are hot spots for 0, 
and -144 dB.  
The Up and Down Arrow keys on 
your keyboard can be used to 
control the volume.

NOTE: iTunes and Amarra Volume 
are kept in sync. 

NOTE: You may notice a small 
delay and a small doubling of 
sound when using the iTunes 
Volume is being moved.
 
NOTE: Volume will be hidden if
window is too small.

4.  TRACK INFORMATION
The upper display shows name 
and artist for the track. 

Gain is displayed in Red if not 0 
along with the dither status.

At the bottom the memory 
being used for CACHE playback. 
Sample Rate, current time, and 
EQ Settings are displayed

5.  PLAYLIST
This button sets the
Playlist as the source.

6. TRACKS 
This displays the list of tracks 
loaded in the current Playlist. 

9. ARTWORK 
This displays the artwork for
a Track (if it is available).  Use the 
small “x”to hide the artwork. 

3.  CACHE PLAYBACK
CACHE Loading for playback. 
 
When enabled songs are first
pre-loaded into RAM to minimize 
disc access. This can be used in 
Amarra or Playlist Modes.

1 2

4

5 8763 9

8. CONTROLS
These buttons control 

    Playback Options
     - Stop at end
     - Repeat Playlist
     - Load next set of tracks

   Playlist Menu
    - Add Tracks from iTunes
    - Add Tracks from Finder
    - Control Playlist

    Link Remote 
    - allows iTunes / Remote
      to control Playlist

    Link Windows:
   - keeps iTunes and Amarra
     window in synchronization
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When you launch MINI,  iTunes will automatically launch.  Likewise, when iTunes quits Amarra will 
be shutdown. In the Preference Window, there is a check box which can be used to disable the 
auto launch / quit feature.

6.2. 0  Amarra EQ

This section presents an overview of the Amarra EQ.  Use this to alter the sonic characteristics of the sound.  
Amarra EQ employs a minimal phase topology and double precision operations to ensure inaudible results 
while preserving the fidelity of the most delicate acoustic performances.  

The EQ window is opened by clicking on the EQ button at the top of the Amarra window.
Use Option-Click on the EQ button to mute the EQ.

The EQ can also be set using the EQ presets as set in the Track Information from iTunes.
Select a Track in iTunes and using “Get Info” select the “Options” Tab and set the EQ Preset.
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EQ (On/Off)
This turns on Amarra EQ, or when 
unlit indicates the EQ is not being 
used.

PRESETS

PARAMETRIC 1

Amarra EQ:
Use the Amarra EQ window to alter the sonic characteristics of the sound.  Amarra EQ employs a minimal 
phase topology and double precision operations to ensure inaudible results while preserving the fidelity of the 
most delicate acoustic performances.  

Amarra comes with a set of EQ settings that are modelled on the iTunes presets. In addition there are 3 Room 
Node settings for common bass adjustment processing.

NOTE: The Desk menu items allows you to save and recall your EQ settings.  Set up an EQ, go to the 
Desk menu and select Save Sonic EQ Set Up.

NOTE: Amarra will also use the EQ Preset defined in iTunes to set the EQ for a Track.

Parametric EQ : 
The parametric filter has parameters for Resonant Frequency,  Gain and Quality Factor.  The Quality Factor, or 
Q, is defined as the resonant frequency, or center frequency in the case of a symmetrical filter, divided by the 
bandwidth. The filter is a 1st Order filter.  

PARAMETRIC 2

PARAMETRIC 3
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Amarra provides three parametric filters to tailor your sound: . All processing is done using 64bit floating point 
arithmetic.   The parametric filters are classic, three parameter versions, with Resonant Frequency, gain, and 
Q. Q or Quality Factor is defined as the resonant frequency, or center frequency in the case of a symmetrical 
filter, divided by the bandwidth. The bandwidth is, in turn, defined as the one or two frequencies at which the 
filter response is 3 dB up or down from unity gain.

The Amarra EQ Window also has a set of presets based on common Room Nodes for correcting simple 
room acoustics. Additional presets are based on an analysis of iTunes EQ Presets. Amarra uses the Sonic EQ 
to process the audio and provide the selected effect..  The following presets are provided:

Default	User Setting
Acoustic					   
Bass Booster
Bass Reducer	
Classical	

Curves for Parametric EQ ::
The family of curves shown below include a wide Q of 0.5, 
a medium Q of 2.0 and a narrow Q of 10. The order or 
slope of this filter is 6 dB per octave.

As an example, a parametric filter with a Q of 1 has a 
bandwidth of 100 Hz when its center frequency is set 
to 100 Hz but, it has a bandwidth of 1000 Hz when the 
center frequency is set to 1000 Hz.

Expressing the width of a filter as a Quality Factor, rather 
than bandwidth, provides a more intuitive sense of the 
filter’s subjective “sound,” since the same value of Q will 
produce different bandwidths at different frequencies. The 
higher the frequency, the wider the bandwidth will be for a 
given Q value, which roughly corresponds to our auditory 
mechanism’s ability to perceive a filter’s action. 

Jazz
Pop
R & B
Rock
Flat

Room Node = 30 Hz
Room Node = 40 Hz
Room Node = 50 Hz
SACD Filter
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6.3.0   MINI Preferences

This section presents an overview of the MINI Preferences. 

LAUNCH SETTINGS 
LAUNCH  /  QUIT ITUNES:: Forces iTunes to launch 
or quit in sync with MINI.
HIDE ON LAUNCH ::  Forces MINI to hide its windows 
after startup.
LINK ITUNES WINDOW :: Forces iTunes to remain 
‘attached’ to Amarra’s main window, regardless of the main 
window’s location. 
LINK ITUNES EQ PRESETS :: Forces Amarra to follow 
the EQ settings in iTunes.
PLAYLIST FOLLOWS ITUNES ::  Forces Amarra’s 
Playlist to follow the track selections in iTunes
-------------------------------------------------
PLAYBACK SETTINGS:
BYPASS COMPRESSED FILES ::  Forces Amarra to 
skip over lossy encoded music files like MP3 and AAC.
    Useful for PPC Macs.
TRACKS TO LOAD :: Sets the number of consecutive 
tracks that Amarra pulls from iTunes when auto-populating a 
Playlist.
MEMORY AMOUNT ::  Set the amount of Random 
Access Memory that Amarra uses to temporarily store audio 
in Cache Mode.
-------------------------------------------------
DITHER SETTINGS
AUTO-DITHER ::   Automatically enables redithering when 
Amarra’s gain is not set to unity or 0.
TYPE :: 
	 TPDF: Sets Amarra’s redithering function to Sonic 
Studio’s proprietary Shaped TPDF (Triangular Probability 
Density Function) dither type.
	 MBIT+: Sets Amarra’s redithering function to 
iZotope’s proprietary MBIT+ dither type.
	 Shape: When Type is MBIT+, sets the amount of 
spectral shaping, from none to extreme.
	 Wordlength: Sets the number of bits for Amarra’s 
output. This setting should match your DAC’s word length 
specification. If set to less than 24 bits, Auto-dither should be 
enabled for best quality.
-------------------------------------------------
PROCESSING SETTINGS 
FULL SONIC-EQ :: Changes the Equalizer from iTunes-
style generic curves to fully adjustable, minimal phase Sonic EQ. 
Not available in MINI or Junior.
Pure Gain ::  Forces Amarra to change gain in 1 bit steps for 
less gain interpolation and higher quality.
Hard Limit ::  Changes the way Amarra  reproduces  consecutive 
over samples. Recommended for music with limited dynamic range. 
-------------------------------------------------

-------------------------------------------------
SONIC HARDWARE SETTINGS ::
    Requires Sonic Studio Hardware. 
Launch/Quit Console: Forces Sonic Console to launch 
or quit in sync with Amarra.
Dim Front Panel: Dims the front panel display.
Control Volume: Interlocks Amarra’s gain control with 
the hardware gain control so either can be used.
Gain Adjustment: Set the system gain to match 
professional (0 dB) or consumer electronic (-10 or -14 dB) 
standard levels.
-------------------------------------------------
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If dither is enabled then the output of MINI will be dithered to the setting of the Output Wordlength specified.  
This can be useful for providing the a better sound when Gain is used or if your DAC only supports a limited 
word length (16 or 20 bits).  

NOTE: When the Output Wordlength is set to 24 bits the dither will be “disabled” if the Gain 
has not been modified (at full volume). Once the Gain is adjusted then dither is re-enabled.

MINI provides two dither options:  Sonic TPDF and Izoptope’s mBIT+ Dither.  The mBIT+ is an advanced 
psychoacoustic dither and supports different shapes: Light, Medium, High, Ultra, 

6.4.0  Using MINI with Remote Control

6.4.1  Remote Control Volume 
You can use your iTouch / iPhone iTunes Remote to control the Volume in MINI. When you adjust the volume 
using your Remote (or using iTunes) MINI will follow.  

NOTE:  You may notice a small doubling of sound while using the remote volume control.  This 
             will stop once you stop moving the volume (iTunes will mute).

6.4.2  Using MINI with Infrared Remote Control

The MINI Remote Application is used to support the Apple Infrared Remote.  The MINI Remote Application 
can be found in your Extras Folder and is only required for the infrared. 

We can also recommended the “rowmote” iPhone/iTouch Application available via the iApp Store. 
For more information please visit http://www.rowmote.com/Rowmote/Rowmote.html

6.4.3  Using MINI with Remote Control And Playlists

With Release 2.3 you can use the Apple Remote to control the Playlist.  Use the “Link Remote” Preference 
to enable this feature.  When Enabled you can choose tracks in iTunes (or Apple Remote) and the Playlist will 
automatically follow. Likewise, selecting a song in an MINI Playlist will select the iTunes track.

NOTE: If you Add files from the Finder than this feature will Not Be Used.

    NOTE: This may cause dropouts and skips with large iTunes libraries.
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6.5.0  Using your Airport Express

Using the “Airfoil” application from Roque Amoeba allows you to route the output of MINI to an Airport Express.  For more 
information visit http://www.rogueamoeba.com/airfoil/mac/ for more information.
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6.6.0  MINI Playlist Mode

MINI Playlist

MINI provides its own Playlist window that can be used to control playback of soundfiles instead of iTunes.  
The playlist is also used for playback of gapless material  (reads the iTunes Gapless tag).  Tracks can be loaded 
via a selection iTunes (from the Library, from an iTunes Playlist or from a CD) or using the Finder.  You can also 
Drag and Drop files from the finder or from iTunes itself onto MINI to add them.

NOTE: Use Playlist mode for playback of gapless recordings.  Make sure the Gapless 
option is enabled for each song of a gapless recording.  
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iTunes song Get Info dialog box, Options tab.

Playlist Navigation ::
Left Arrow = skip to next track and play it
Right Arrow = skip to previous track and play it
Down or Up Arrow = move to another track without stopping playback of current track.  Hitting the 
Return key or spacebar 2 times stops the current track’s playback and starts playback of the newly 
selected song.

LINK BUTTON 

- This button will link the Playlist window to the MINI Window.

PLAYBACK OPTIONS

Using the Playback Options button on the MINI window you can choose to stop the playlist, repeat or load 
the next set of consecutive tracks in to the Playlist. 

- Do Not Repeat Playlist and stop at end.

- Repeat Playlist from top.
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- Load the next set of Tracks when this playlist is finished.

ADD ITUNES / LOAD ITUNES/ ADD FINDER 
Files can be added from iTunes or from the Finder using these commands.  The Add Finder command will prompt you to 
selected files to load.  You can select multiple files and folders.
 
USING APPLE REMOTE VOLUME
You can use your remote to control the Volume using your Apple Remote or Rowmote Application.

USING LINK REMOTE  PREFERENCE
With the “Link Remote” preference enabled MINI will automatically load Tracks into the Playlist based on the selection in iTunes 
(which can be controlled using Apple Remote). 

NOTE: If any files are added from the Finder then this preference is not enabled.

DRAGGING FILES AND FOLDERS
Files can be added from iTunes or from the Finder by dragging the Files or Folders from the Finder to the Playlist Window.  You 
can also drag Tracks from iTunes.

NOTE:  Inserting a CD into your Mac’s drive can yield stunning results when played back through 
a Playlist.  Select the CD in the left margin of iTunes, then press the ADD ITUNES button in MINI.
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7.0.0  Registering Your MINI Software

In order to receive warranty service, you must register your product with Sonic Studio. This may be done at 
any time with proof-of-purchase.  We strongly recommend that you register with Sonic Studio as soon as you 
purchase your unit.  This will ensure the best possible support for your purchase.

1. Your product will be registered with us.
    Registration is used as proof of ownership if your product is ever lost or stolen.

2. Sonic Studio updates MINI software on a regular basis.
    This allows us to keep you informed of updates as they become available.

Please register your MINI software using our automated registration Web page at:
	 http://www.amarraaudio.com and click on Support => Register

Alternatively,  our mail address is:
	 Amarra Software Registration 
	 Sonic Studio, LLC
	 330 Sir Frances Drake Blvd
	 Suite A
	 San Anselmo, CA USA
	 94960-2552
	 Fax 1-775-330-8923

If you encounter issues using MINI please refer to the information below for assistance. If none of these steps 
address your problem please contact your dealer or Sonic Studio support for more help.



8. 0.0  Troubleshooting Guide

Basic Macintosh Setup Tips
	 iTunes:
		  • Disable the Crossfade Songs preference in iTunes
		  • Disable the Sound Enhancer preference in iTunes
		  • Disable the Sound Check preference in iTunes

	 Energy Preferences
		  • Disable Sleep and other Energy saving Preferences.
	 Bluetooth
		  • Disable Bluetooth
	 Spotlight
		  • Disable Spotlight
	  Security
		  • Disable Infrared
	 TimeMachine
		  • Disable TimeMachine on your media drives.

	 • We highly recommend a fresh install of the operating on a clean disc. 
		  This can prevent problems later on.

	 • We also recommend that your computer be used exclusively for music playback. 	
		  Email, web browsers, screen sharing and other applications can effect performance.

Issue:	 Amarra Authorization Answers.  

I have entered my code and password correctly with a new password to do a re-activation, 
why is the application not being re-activated?
 

Verify that you have an Internet Connection. Your new password must be a new and never-used 
password. Verify that you have not previously used this password with this activation code. 
 
How often will my application connect to the activation server via the Internet? 
 
 Your application uses the Internet when it is first installed, when it is re-activated (such as after a disk 
reformat and reinstall, or if the software is moved to a new computer). The application may also do a 
quick check with the server when you run the application. 
 
software_DNA includes an anti-fraud system that disables activation codes in cases of credit-card 
chargeback or refund. Unless you are using offline activation (see below), your application will need 
to connect to the Internet at least once a month to verify the license status. When an activation code 
is revoked, the software remains in trial mode until a new, valid activation code is provided. 
 

Will my application work if I don’t have an Internet connection? 

Yes, there is an offline activation method available. If no Internet connection is found during activation, 
or the activation server is not reachable, the software will ask you to do offline activation. The software 
will provide step- by-step instructions, where a file is written to disk that you move to a computer 
that does have Internet access (or email access). You can move this file via LAN, floppy disk, CD-R 
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or USB key. You can use your Internet browser (on a machine that does have Internet access) to visit 
a special page to upload this file and receive another file in return. If you do not have any working 
browsers then the file can be emailed to our tech support (note there may be a delay in the return 
of the file depending on the time of day and week).  

During activation what information is passed to the server? 
  

No personal information or information about your computer configuration are transferred. There is 
a one-way hash* of some machine configuration data, your chosen password, and the optional email 
address sent to the server. Your application may have an optional registration page and if you choose 
to fill that out, that information is also transferred during the first activation. If you do not provide 
the optional information (email address and registration information) then no personal information 
will be transferred. We suggest you do not use one of your important personal passwords for the 
activation password, or a password that personally identifies you.  
 
*One-way Hash: Codes that identify parts of the computer are put through a special function (called 
a ‘one way hash’) that turns the codes into one code number that is unique to your computer but 
cannot be deciphered (or reverse engineered) to determine what those components are. Only this 
hash value is sent to the activation server and not the details on the computer parts. 

 
Can I move Amarra to another computer? 
  

Yes, this can be done easily. It is simply a matter of deactivating the application on one computer, 
reinstalling the application on the new machine, and reactivating the software. If you have remembered 
your password this will be a fast and easy process. 

What is the email address for and is it mandatory? 
  

The email address on the activation and reactivation dialogs is mandatory. It can be used to retrieve 
a lost password. When you provide the email address it will not be used for marketing purposes or 
sold / provided to any third party. If you do provide an email address we recommend it be one that 
will be active for some time.  

  
  
What if I have forgotten my password and did not provide an email address (or my email 
address is no longer valid)? 
  

During a reactivation the previously provided password is required. If the password has been lost and 
cannot be recovered (because an email address was not provided, or the email address is no longer 
valid) you will need to contact our support via email or by phone. We will be happy to reset your 
password.  

  
 
Will changes to my computer cause my application to stop working? 
  

There are no changes that will cause a permanent disabling of the software. Major changes (disk 
reformat being one such major change) will mean that you need to reactivate the software. If you 
have your password this will be a fast and easy process.  
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What happens if Sonic Studio or softWORKZ suspends service or goes out of business? 
  

Both companies have been in business for several years, and are healthy and stable and will be around 
for many years to come!  
 
Regardless, your activated application will continue working without the Activation server, although 
new activations or re-activations will not be possible. Both companies are committed to ensure that 
a patch will be made available ASAP to resolve this. Either a version with a replaced activation system 
or a version with no activation will be provided. 

 
  
I wish to do an online activation but my firewall is set up to block such requests. What are 
the firewall settings? 
  

The following is the information that you need to setup your firewall: 
Main server IP address: reg1.softworkz.com 
Backup server IP: reg2.softworkz.com 
Backup server IP: reg3.softworkz.com 
Port: 80 (Standard HTTP) 
Domain: softworkz.com 

Why is an activation system required at this time? 
  

Software companies around the world have come to realize that activation- type copy-protection 
systems provide a reasonable solution to the problem of piracy while at the same time respecting 
customers by not burdening them with a hard-to-use licensing system. Reducing piracy means that 
the software vendor can use steady revenues to further improve the product and guarantee business 
continuation. It is unfortunate that piracy exists because we know the majority of our customers 
follow the license terms but it is a fact of life in this digital age. We trust that this new system will be 
virtually transparent for the majority of customers.  

Issue:	 Amarra operates in demo mode.

Solution:
	 • Amarra requires a Certified Audio Interface to operate in non-demo mode.

Issue:	 How to set up a remote volume

	 Amarra does not support streaming of remote songs.
	 Amarra requires that all volumes be mounted on the computer as a shared volume.

	 Solution:
	 • Mount the remote volume with Read/Write Access on your local Macintosh
		  - Use the Network (Cmd-K) to locate and mount the remote volume
	 • In iTunes used the Add to Library command to add the songs from the Mounted Volume
	 • Mount the remote volume with Read/Write Access on your local Macintosh
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Issue:	 Audio Clicking or Ticking Sound.

	 Solution:
	 • Disable Spotlight (add volumes to the Spotlight Privacy Preference)

	 1) Open System Preferences and locate the Spotlight Preference

	 2) Select the Privacy Tab and add all your media drives

	



Solution:
	 • Disable Network Shared Access.
	
	 1) Open System Preferences and locate the Sharing Preference
	 2) Disable Web Sharing, Remote Login and Remote Management.
	     Please note for support the Remote Management preference may be required.

Solution:
	 • Disconnect multiple FireWire devices and reduce daisy-chained connections.	
	
	 Solution:
	 • Shut down other applications such as email and browsers.	
	
	 Solution:
	 • Increase the amount of RAM in your computer.	

	 Solution:
	 • Check that all drives are HFS formatted. 
	   Amarra does not support FAT32 drives.	

	 Solution:
	 • Change the Sample Rate manually using Audio Midi Setup to a different value.
	    Then switch the Sample Rate back.	
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Issue:	 Songs do not change or sound correctly.

	 Solution:
	 • Disable the Crossfade Songs preference in iTunes
	 • Disable the Sound Enhancer preference in iTunes
	 • Disable the Sound Check preference in iTunes
	 • Disable Sleep and other Energy Preferences.

Issue:	 MINI does not play audio.

	 Solution:
	 • Check Permissions - Are they Read / Write
	 • You may also Quit MINI and iTunes and restart MINI.
	
	 NOTE: Sound files with names that contain “:” or other 
		  Foreign characters may not play properly.  
		  Changing the name of the soundfile can fix this.

Issue:	 MINI does not play audio.

	 MINI requires an input clock under Audio Midi Setup. 
	 If your devices does not have an input when shown under AMS then please
	 follow the instructions for creating an Aggregate Device.

	 Solution:
	 • Create an Aggregate Device under Audio Mini Setup. 
	 Please refer to the Aggregate Device Setup in the Documentation Folder.

Issue:	 Sample Rate Does Not Change With Soundfile.
	
	 Does your device support the sample rates for your music?
		  MINI will only use the available rates on the device. 
		  Otherwise, iTunes will be used (and sample rate conversion will occur).



9.0.0  Support

We are committed to your successful use of MINI and offer support for MINI through your local dealer or 
via phone and email through Sonic Studio.  Please also ask your local dealer for assistance.  They have a great 
deal of knowledge about MINI and are an excellent resource.

For email support, send email to:  

support@sonicstudio.com

You can always find the latest information and updates for MINI at our website:

www.amarraaudio.com
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